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About this Manual 

The Report User Guide provides an overview of the Oracle Instantis EnterpriseTrack reports 
module. It shows you how to generate and modify standard, ad-hoc, and user-defined reports. 

In This Section 

Document Conventions ............................................................................................. 7 

Document Conventions 

The following conventions are used in this manual to convey instructions and information:  

The description of a menu item and its sub-items is described in this document as (Page Menu) 
View > Toolbar >Display Print-Data Toolbar, where you should click on the View Page Menu, 
then find the Toolbar sub-item and then click on the Display Print-Data Toolbar sub-item. 

 Screen names and field names are in bold text. 

 The actions you need to take on each screen are in bold text. 

Getting Around in EnterpriseTrack 

In This Section 

Navigating within EnterpriseTrack ............................................................................. 7 
Navigating to the Reports Module ............................................................................. 9 

Navigating within EnterpriseTrack 

The menu system consists of an Application Level Menu, Module Level Menu, Page Level menu 
and an Item Level Menu. Common functions are grouped together throughout the application. 

Application Level Menu: Appears in the Top Navigation Bar and provides access to all major 
modules and components of EnterpriseTrack. 

Module Level Menu: Appears as the right most item on the left side of the Top Navigation Bar. 
This menu appears when you are in a specific module of the application, specifically within a 
particular Idea, Proposal or Project. It provides access to commonly used functions within the 
module. 

Page Level Menu: Appears within each page of a module and provides access to functions that 
are relevant only to that page. 

Item Level Menu: Appears within each page in lists of items like activities on the Roadmap 
(WBS) page. It allows you to perform actions specific to that item. 
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Using the Top Navigation Bar

The Top Navigation bar is active when you log into the system. It contains the Application Level 
menu and depending on the context, a Module Level menu. 

 The  Home button takes you to your default home page and is set by you Administrator. 
When the Left Navigation bar is hidden, it is displayed on the blue banner. When the Left 
Navigation bar is displayed, the Home button is displayed on the Left Navigation bar. 

 The Go To menu provides access to all major modules within the EnterpriseTrack system. 
The items displayed in this menu depend on the features enabled for your deployment and 
your permissions. 

 The Create menu displays menu options to create a new project, proposal, idea, program, 
resource or message, etc. 

 The My EnterpriseTrack (terminology is configurable) menu displays options that take you 
to your specific actions and settings. It shows your work (all open actions on Projects, 
Proposals, Ideas etc. that are assigned to you), your messages, certifications, permission, 
profile, preferences and passwords. 

 The View menu allows you to display toolbars at the Top banner, and Left Navigation bar. 
You can also save your settings. 

 The project type ahead text box provides easy navigation to any project in the system. 

 In the text box Type Project ID or name, you can type the Project ID or any part of the 
name and as you type, the system gives you project choices that match the ID or name you 
are typing. 

 The Advanced Search menu gives you different ways for searching the system. You can 
search on projects, proposals, documents, etc. 

 From the Help menu, you can launch the online help in a new window or launch User 
Productivity Kit (UPK). 

 Click on Logout at any time to log out of the application. 

Using the Left Navigation Bar

To display the Left Navigation bar, from the Top Navigation bar select the View menu and 
choose Display Left Navigation. Select if you want to display icons only or icons and text. The 
Left Navigation bar provides access to all modules in the EnterpriseTrack system. The list of 
menu items displayed depends on the features enabled for your deployment and your 
permissions. As you drag the mouse over these items, you will see the clickable items change 
color. Current selections are always highlighted. Clicking on any of these options typically takes 
you to a listing page with summary information. 

Use this  button to expand and collapse the Left Navigation bar to shows icons and text or 
just icons. 

Important!

Do not use the browser's Back and Forward buttons to navigate to a 
different page. Use the left navigation bar and/or the buttons provided 
within EnterpriseTrack. 
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Navigating to the Reports Module 

To navigate to the Reports module, from the Top Navigation bar select Go To > Reports> 
View. 

About Standard Reports 

Standard reports are pre-defined cross-project reports. From the Reports module, you can 
perform the following actions: 

 run reports 

 customize reports by changing the filter and output parameters 

 bookmark reports 

 copy reports 

 delete reports 

 share reports 

 schedule and email reports 

 save report history 

 view report history 

You can restrict these reports to either an initiative, or across multiple initiatives.  

In This Section 

Working with Standard Reports ................................................................................. 9 

Working with Standard Reports 

To access Standard Reports, select Go To > Reports > Standard from the Top Navigation bar, 
or select Reports >Standard from the Left Navigation bar. The reports are organized into 
folders.  

 My Reports: contains all reports that you have created. 

 Shared Reports: contains all reports that have been shared by other users. 

 Pre-defined Reports: contains all reports that are pre-defined in the system. 

 Global Reports: contains all global reports. 

 Custom Reports: contains all reports that are customized for your system. 
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In This Section 

Running Standard Reports ...................................................................................... 10 
Saving and Customizing Standard Reports ............................................................. 10 
Bookmarking Reports .............................................................................................. 18 
Deleting Reports ...................................................................................................... 18 
Copying Reports ...................................................................................................... 18 
Managing Report Folders ........................................................................................ 18 
Pre-defined Standard Reports ................................................................................. 19 

Running Standard Reports 

To run a standard report:  

1) Select Go To > Reports > Standard from the Top Navigation bar, or select Reports 
>Standard from the Left Navigation bar. 

2) From the Tree pane, select a reports folder.  

3) From the List pane, select a report. 

4) Click Run Report to run the report using existing filters and output parameters. Click 
Run with Filters to modify filters or output parameters.  

5) To modify filters: 

a. From the Details pane, select the Filters tab. 

b. Click  Expand All to expand the filter categories. 

c. Modify the filters. 

d. Click Run. 

6) To modify output parameters:  

a. From the Details pane, select the Output tab. 

b. Select an output format. 

c. Choose additional output parameters 

d. Click Run. 

Saving and Customizing Standard Reports 

Saving Reports 

You can save an existing standard report to customize settings. You can: 

 Modify the name of the report 

 Select and save the filter parameters and output criteria. 

 Select filter and output parameters that are visible and editable when reports are run. 

 Schedule run frequency. 

 Manage run report history. 

 Share reports. 

All reports you save are displayed under the My Reports folder.  
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To save and customize a standard report: 

1) Select Go To > Reports > Standard from the Top Navigation bar, or select Reports 
>Standard from the Left Navigation bar. 

2) From the Tree pane, select a reports folder.  

3) From the List pane, select a report. 

4) From the Details pane, select Save As. 

5) In the Save the Report As window: 

a. Select a folder name, or enter a name to create a new folder under My Reports. 

b. Enter a name for this report. 

c. Click Save. 

Selecting Filter Parameters 

You can selectively narrow the filters and output options to enable only a subset of these 
settings to be editable, visible or editable/visible when reports are run. To select the filter 
parameters that you want to view and edit when this report is run: 

1) From the Tree pane, select My Reports.

2) From the List pane, select a report. 

3) To select the filters you want visible and editable during runtime: 

a. From the Details pane, select the Filters tab. 

b. Click Edit. 

c. Click the Visible check box next to filter parameters you want visible. 

d. Click the Editable check box next to filter parameters you want to edit. 

4) Click Save. 

Using Finance Filters 

The following table lists the available finance filters. The (Set 1) and (Set 2) are two sets of filters 
for two sets of output columns in the Finance Group Aggregate and the Finances Element 
Aggregate reports. The two sets allow you to compare finance aggregate values.  

Filters Pull-down Values Description 

Finance Template The finance 
templates 
configured by your 
administrator. 

Select the finance template you are using. 
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Finance Type  Locked 

 Unlocked 

 All (Locked and 
Unlocked) 

Locked: All finance values before the lock 
date. 

Unlocked: All finance values after the lock 
date. 

All (Locked and Unlocked): All forecast 
values. 

This option is not displayed for the Proposal 
Finance Element Monthly Detail Report. 

Finance View  Plan 

 Actual 

 Forecast 

 Plan or Basic 

 Actual or Basic 

The options displayed here are based on 
the finance template you selected. If the 
template you selected supports double 
view, the following options are displayed: 
Actual, Plan, and Forecast. If your selected 
template supports single view, you will only 
have the option to select Basic. If no finance 
template is selected, you will see the 
following options:  

 Plan or Basic: This option is displayed if 
there are some projects that use the 
double-view functionality and some that 
use the single-view functionality. The 
Plan value come from projects that use 
the double view functionality, and the 
Basic value come from projects that use 
the single view functionality. 

 Actual or Basic: This option is displayed 
if there are some projects that use the 
double-view functionality and some that 
use the single-view functionality. The 
Actual value come from projects that 
use the double view functionality, and 
the Basic value come from projects that 
use the single view functionality. 

This option is not displayed for the Proposal 
Finance Element Monthly Detail Report. 
Only Plan values are displayed. 
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Date Range  This Fiscal Year

 Previous Fiscal 
Year 

 Next Fiscal 
Year 

 Any start to end 
month 

 All Fiscal Years 

 Trailing 12 
months 

 Next 12 months 

 This Fiscal Qtr 

 Previous Fiscal 
Qtr 

 Next Fiscal Qtr 

 This Fiscal Year 
Q1 

 This Fiscal Year 
Q2 

 This Fiscal Year 
Q3 

 This Fiscal Year 
Q4 

 Current Month 

 Previous Month 

 Next Month 

The range of months that are used to 
generate the aggregate value of the Total, 
Group1, Group 2 etc., columns in the 
aggregate reports. For Monthly reports, this 
determines the months that will be 
populated in the output, all other months will 
have 0 values. 

For Annual totals, use one of the different 
Fiscal Year choices. For Quarterly totals, 
use one of the different Quarter choices. If 
you want totals for a particular month, use 
one of the Month choices. For a range of 
months, use Any start to end month 

You can choose aggregation of past or 
future months. 

Snapshot (for Plan) 

Snapshot (for 
Actual) 

Displays a complete 
list of snapshots. 

The system shows the complete list of all 
snapshots taken in the drop-down list (up to 
a limit of 100). To ensure consistent 
aggregation of values, it is recommended 
that all users that make snapshots use a 
consistent naming scheme. The Default 
Plan Snapshot is always at the top of the 
list. 

This option is not displayed for the Proposal 
Finance Element Monthly Detail Report. 



Report User Guide

14

Finance Detail 
Level 

 Total 

 Group 

 Category 

 Element 

The filter sets the level of detail of the 
Finance element hierarchy that is shown in 
the report. This also sets the number of 
rows in the output per project. 

Total: shows only the top level (Total). 

Group: shows the Group level, one level 
below Total (up to 5, depends on number of 
Groups configured) 

Category: shows the Category level, 2 
levels below Total 

Element: shows the Element level, 3 levels 
below Total 

Show Upper Levels  Yes 

 No 
This filter decides if the output should show 
higher levels of the Finance items hierarchy 
when a lower level item is chosen in the 
Finance Detail Level filter above. 

This is relevant if you are doing your own 
aggregation of the element level values 
using Excel and you do not want the 
Category, Group, Total level values to 
interfere with this aggregation. 
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Start Month 

End Month 

This filter field displays only if the selected 
date range is Any start to end month. Use 
the calendar picker to select the start and 
end dates. 

Validation Approval 
Date (From) 

Validation Approval 
Date (To) 

This filter field displays on the Finance 
Validation Report. If validation approval 
dates are entered, only approved 
validations are returned. 

Finance Aggregate Report Filters

The table below describes the additional output parameters for the finance aggregate reports. 

Output 
Parameters 

Description 

Starting 
Month 

Enter the starting month. This output setting decides which set of 
months will be shown in the report output. 
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Output 
Parameters 

Description 

Number of 
Months 

Enter the number of months. For instance, you may set the number of 
months to 36 starting with January 2010 for several runs of this report. 
Then depending on the Date Range filter setting (above) varying sets of 
months of these 36 will be populated for different runs of the report. 

Break down 
Finance 
Details by 
Organization 

Select this check box to expand the finance details by organization. 
Each finance line item in the report is expanded and broken down to 
show the finance allocation by organization. 

Note: This report is usable only if the finance allocation percent totals 
100%. The system displays a warning message if it does not equal 
100%. 

Selecting Output Parameters 

To select the output parameters that you want to view and edit when this report is run: 

1) From the Tree pane, select My Reports.

2) From the List pane, select a report. 

3) To select the output parameters you want visible and editable during runtime: 

a. From the Details pane, select the Output tab. 

b. Click Edit. 

c. Click the Visible check box next to parameters you want visible. 

d. Click the Editable check box next to parameters you want to edit. 

4) Click Save. 

Scheduling and Emailing Reports 

You can choose to run reports manually or on a schedule. If you select scheduled, you can 
decide the following options: 

 The run frequency you want to use. 

 If you want to receive email notification when the report is run. 

 If you want to include the report as an email attachment when email notifications are sent. 

The system sets an expiry date for all scheduled reports as they often continue to run in the 
background, drawing system resources from other processes and degrading overall 

performance. The Expired  icon is displayed next to reports that have expired. The expiry 
date is based on the scheduling frequency. Daily reports expire after 30 days, weekly reports 
after three months, monthly reports after one year, and yearly reports after one run. An email is 
sent to the report owner and/or specified recipients on the day of a report's expiration to enable 

continuation of the report if desired. You can renew scheduled report by clicking the Renew 
icon, or you can click the Renew button from the Schedule and Email tab. 
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To schedule a report: 

1) From the Tree pane, select My Reports.

2) From the List pane, select a report. 

3) From the Details pane, select the Schedule and Email tab. 

4) On the Schedule and Email tab: 

a. Click Edit. 

b. Select the run type: Manual or Scheduled. 

5) If you selected Scheduled: 

a. Select the day of the week, date, month and year to configure the run frequency. 

b. Choose if you want to email this report. 

c. Choose if you want send the report as an attachment. 

d. Select or enter the email addresses 

6) Click Save. 

On the List pane, the reports that are scheduled have the Scheduled icon. 

Note: If your administrator has disabled your scheduled report, it is 
displayed on the Schedule and Email tab. 

Saving Report History 

You can select how often you want to save the run report history.  

To save report run history: 

1) From the Tree pane, select My Reports.

2) From the List pane, select a report. 

3) From the Details pane, select the History tab. 

4) On the History tab: 

a. Click Edit. 

b. Select how often you want to save the report history. 

5) Click Save. 

Viewing Report History 

The report history shows the number of times the selected report was run, if it was a scheduled 
or a manual run, the format of the report, and the report output. If a report is shared, it also 
shows the names of people who ran the report. 

To view the report run history: 

1) From the Tree pane, select My Reports.

2) From the List pane, select a report. 

3) From the Details pane, select the History tab. 
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Bookmarking Reports 

You can bookmark reports that you want to access frequently. The display and filter parameters 
that are currently set are used to generate this report. 

To bookmark a report: 

1) Select Go To > Reports > Standard from the Top Navigation bar, or select Reports 
>Standard from the Left Navigation bar. 

2) From the Tree pane, select a reports folder.  

3) From the List pane, select a report. 

4) From the Details pane, select the General tab. 

5) Click  Bookmark this report. 

6) Select a folder and click Add. 

Deleting Reports 

To delete a report: 

1) From the List pane, select a report. 

2) Click Delete. 

Copying Reports 

To copy a report: 

1) Select a report from the List pane. 

2) Click  Copy.  

3) From the Tree pane, select a folder under My Reports. 

4) From the List pane, click Paste. 

Managing Report Folders 

You can copy an existing report folder to edit the folder name, add reports, delete reports, and 
adjust filters and output parameters. 

To copy a report folder: 

1) From the Tree pane, select the report folder you want to copy. 

2) Click Copy. 

3) Select the My Reports folder. 

4) Click Paste. A copy of the selected folder is now in your My Reports folder. 

5) From the Details pane, click  Edit to change the name of the folder. 

To delete a report folder: 

1) From the Tree pane, select the reports folder. 

2) Click Delete.  
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Pre-defined Standard Reports 

Finance Reports 

In This Section 

Project Finance Spreadsheet Report ....................................................................... 19 
Project Detail Spreadsheet Report .......................................................................... 20 
Financial Savings by Business Unit ......................................................................... 21 
Finance Summary Report ........................................................................................ 22 
Finance Aggregate Reports ..................................................................................... 22 
Finance Validation Report ....................................................................................... 27 

Project Finance Spreadsheet Report 

This report generates a project finance report using the specified filter and output options. This 
CSV report is used in conjunction with the macro in the downloaded template. The Data sheet is 
an aggregation of project financial data based on the hierarchy configured in the finance 
template. The default range of the report is the current fiscal year. 

Note: You must first download the template before you can view the 
output in MS Excel. 

This report is designed to export the contribution each element line item makes to the finance 
category, group and total levels after applying the relevant multiplication factors. To identify the 
month, the report uses Q to represent the quarter and M to represent the month, for example if 
the fiscal year starts in January, January would be displayed as Q1_M1 and February as 
Q1_M2.  April would be Q2_M1 as it is the first month of the second quarter. There are four 
columns for each month representing the four different levels of the template as follows: 

 Qx_My_1 maps to the monthly value for the total level 

 Qx_My_2 maps to the monthly value for group level 

 Qx_My_3 maps to the monthly value for category level 

 Qx_My_4 maps to the monthly value for element level 

The columns M2, M3 and M4 map to the multiplication factors for group (M2), category (M3) and 
element (M4).The data on this report is tailored for manipulation into a pivot table.  

Filter Parameters

You can filter on pull down status, initiative, project basics, classification fields, organization 
hierarchy, and finances. 

Output Parameters

You can select the report format, the maximum rows per report, and if the output should be 
compressed. The report output is in CSV format. 
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Sample Report

Project Detail Spreadsheet Report 

This report displays a detailed project report using the specified filter and output parameters. 
This report is designed to be used with the macro in the downloaded template. The Data sheet 
shows one row per project and the default range of the report is the current fiscal year. 

Note: You must first download the template before you can view the 
output in MS Excel. 

Filter Parameters

N/A 

Output Parameters

The output is in CSV format. 
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Sample Report

Financial Savings by Business Unit 

This report displays financial savings by business unit using the specified filter and output 
options. The report groups projects by Business Unit (second level of the organization hierarchy) 
and displays the YTD and financial forecast for each project in the In-Realization phase. 

Filter Parameters

You can filter on initiative and finances. 

Output Parameters

You can select the report format and choose to compress the output. The output is in CSV 
format. 

Sample Report
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Finance Summary Report 

This report displays the finance summary using the specified filter and output parameters. This 
report aggregates planed or actual finances by Group, Category, or Element for each fiscal year 
for all projects based on your filters. Before running this report, you must choose a Finance 
Template, Finance View, and a Finance Type. 

Filter Parameters

You can filter on pull-down status, initiative, finances, project basics, project dates, organization 
hierarchy, project custom fields, classification fields, and alignment trees. 

Output Parameters

The available report formats are: CSV, HTML, and PDF.  

Sample Report

Finance Aggregate Reports 

You can configure the three Finance Aggregate Reports with the use of a small set of filters to 
create a report output that is best suited to your needs. You can also use these reports as data 
sources to generate highly specific output in the form of Excel charts, pivot table and any 
company-style formatted output (See topic Creating User-Defined Excel Reports). 

The four Finance Aggregate Reports provide increasing levels of detailed information. They also 
provide extensive columns of non-financial information about projects such as– organization, 
classification, users, custom fields, etc. The hierarchy of finance information can be visualized 
as:  

Total 

Group1 

Category 1.1 

Element 1.1.1 

Total refers to the sum-total finance value of a Project. Group1, 2, 3, 4, 5 refers to the items in 
the Finance Template hierarchy you have configured just below the Total level. Categories are 
the items below Groups and Elements are the items below Categories.  
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Sample Report

The sample below is an example of what you can do by using the data generated from the 
Finance Aggregate Reports as data sources to create custom generated user reports. 

In This Section 

Project Finance Group Aggregate ........................................................................... 23 
Project Finances Element Aggregate ...................................................................... 24 
Project Finances Element Monthly Detail ................................................................ 25 
Proposal Finance Element Monthly Detail Report .................................................... 26 

Project Finance Group Aggregate 

You can generate a finances group aggregate report by using the filter and output options. This 
report shows one row per project. It aggregates the Group 1 to Group 5 and Total financial 
values over a chosen date range based on the filter settings.  Before running this report, you 
should choose a Finance Template. 

Filter Parameters

You can filter on pull down status, initiative, project basics, project organization hierarchy, project 
dates, project classification fields, project custom fields, programs, finances, and finance 
aggregate definition. 

 For more information on filtering, see topic Using Finance Filters. 
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Output Parameters

You can select the report format, choose to break down finance details by organization, and 
select the output columns to display. The output is in CSV format. 

Sample Report

Project Finances Element Aggregate 

You can generate a finances element aggregate report by using the filter and output options. 
This report shows multiple rows per project - one for each element configured item in the 
Finance Template. It aggregates finances at the financial detail level (total, group, category, 
element) based on the filter settings. Before running this report, you should choose a Finance 
Template. 

Filter Parameters

You can filter on  pull down status, initiative, project basics, project organization hierarchy, 
project dates, project classification fields, project custom fields, programs, finances, and finance 
aggregate definition. 

For more information on filtering, see topic Using Finance Filters. 

Output Parameters

You can select the report format, choose to break down finance details by organization, and 
select the output columns to display. The report output format choices are CSV, HTML, and MS 
Excel. 
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Sample Report

Project Finances Element Monthly Detail 

You can generate a finances element monthly detail report by using the filter and output options. 
This report shows multiple rows per project - one for each element configured item in the 
Finance Template. It displays month by month values for the date range based on the filter 
settings.  

Filter Parameters

You can filter on  pull down status, initiative, project basics, project organization hierarchy, 
project dates, project classification fields, project custom fields, finances, program, and program 
organization hierarchy. 

For more information on filtering, see topic Using Finance Filters. 

Output Parameters

You can select the starting month, number of months, report format, choose to break down 
finance details by organization, and select the output columns to display. The report output 
format choices are CSV, HTML, and MS Excel. 
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Sample Report

Proposal Finance Element Monthly Detail Report 

You can generate a proposal finances element monthly detail report by using the filter and 
output options. The number of rows displayed per proposal is controlled by the Finance Detail 
Level filter. It displays month by month values for the date range based on the filter settings. As 
this report only supports Plan view, you cannot use this report to compare views. Program filters 
are displayed only if your administrator has enabled the feature Allow Proposals in Programs. 

Filter Parameters

You can filter on initiative, proposal basics, proposal organization hierarchy, proposal dates, 
proposal classification fields, proposal custom fields, finances, program, and program 
organization hierarchy. 

For more information on filtering, see topic Using Finance Filters. 

Output Parameters

You can select the starting month, number of months, roles, and report format. The report output 
format choices are CSV, HTML, and MS Excel. 

Sample Report
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Finance Validation Report 

You can generate a report to view all project finance validations (approved and pending 
approval). This report displays the project ID, project name, validation type, approved date, 
requested by, requested date, request comments, approved by, and approval comments. If the 
Validation Approval Date (To) and the Validation Approval Date (From) filters are used, only 
approved validations are displayed. 

Filter Parameters

You can filter on initiative, project basics, project organization hierarchy, project dates, proposal 
classification fields, proposal custom fields, and finances. 

For more information on finance filtering, see topic Using Finance Filters. 

Output Parameters

You can select the report format, maximum rows per report, and if the report should be 
compressed. The report output format choices are CSV, HTML, and MS Excel. 

Sample Report
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Listing Reports 

In This Section 
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Idea Listing Report 

Based on your filters, this report displays all ideas in the system. Some of the columns that can 
display on your report include: idea number, title, status, submitter name, initiative, description of 
problem/opportunity, division, business unit, custom fields, primary contact, assignee, 
submission date, date accepted/rejected, and the evaluation score.  

Filter Parameters

You can filter on idea basics, idea dates, idea custom fields, and organization hierarchy. 

Output Parameters

You can select the output columns to display, the report format, the primary output column to 
sort by, sort direction, number rows to display per page, maximum number of rows to display per 
report, and if the output should be compressed. The output choices are CSV and HTML.  
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Sample Report

Proposal Listing 

Based on your filters, this report displays all proposals in the system. Some of the columns that 
can display on your report include: external ID, initiative, proposal ID, name, status, project type, 
roadmap, organization levels, manager, planned start date, actual start date, planned project 
close date, initial forecast benefits, initial forecast cost, and the evaluation score.  

Note: Depending on your configuration, the Project Request Listing is 
the same as Charter Request Listing Report label. 

Filter Parameters

You can filter on initiative, proposal basics, proposal dates, classification fields, organization 
hierarchy, finances, proposal custom fields, program, and program organization hierarchy. 

Output Parameters

You can select the output columns to display, the report format, primary column to sort by, sort 
direction, number rows to display per page, maximum number of rows to display per report, and 
if the output should be compressed.  

The output choices are CSV and HTML.  
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Sample Report

Project Listing 

Based on your filters, this report displays all projects in the system. Some of the columns that 
can display on your report include:  external ID, initiative, project ID, project name, phase, 
status, organization levels, project type, schedule, team size, timesheets #, related entities, 
activities #, project creation dates, classification, unlocked finances, last validation date, and 
evaluation score. 

Note: The Current Phase column is populated only if the project 
roadmap is gated. 

Filter Parameters

You can filter on pull down status, initiative, project basics, project dates, organization hierarchy, 
finances, project custom fields, alignment tree, program, and program organization hierarchy.  

Output Parameters

You can select output columns to display, the report format, primary output column to sort by, 
sort direction, number rows to display per page, maximum number of rows to display per report, 
and if the output should be compressed. 

The output choices are CSV and HTML.  

Sample Report
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Last Modified Date Report 

Use the Last Modified Date report to display a list of entities (project, finance, activity, team, and 
snapshot) that were updated on or after the selected date. For example, if you select Finance, 
all projects that had finances updated on or before the last updated date are displayed. 

Filter Parameters

You can filter on the entity, the last updated date, and last updated time. 

Output (Output Parameters)

You can select the report format and the maximum number of rows to display per report 

The output choices are CSV, PDF and HTML. 

Sample Report

Project Listing Report with Activity List 

Based on your filters, this report displays project details and project activity details like the 
activity, type, sub type, path, name, status, status indicator, number of attachments, tollgate 
activities, owner and dates (plan start, plan completion, actual start, and actual completion). 

Filter Parameters

You can filter on pull-down status, initiative, project basics, project dates, organization hierarchy, 
project custom fields, and activity details like the type, name, status, number of attachments, 
dates, and the status of milestones. 

Output Parameters

You can select the primary output column to sort by, sort direction, number rows to display per 
page, and maximum number of rows to display per report.  

The output choices are CSV, PDF and HTML. 
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Sample Report

Resource Listing 

Based on your filters, this report displays all resources. Some of the columns that can display on 
your report include: external ID, name, login ID, resource status, manager login ID, resource 
type, resource sub type, email address, phone number, access profile, allowed roles, division, 
business unit, region, manager, hours-per week, and initiative. 

The Hours-Per Week column displays the hours per week a resource can work and is taken 
from the resource calendar. 

Filter Parameters

You can filter on initiative, resource basics, time reporting and rates, resource dates, 
organization hierarchy, and resource filterable custom fields. 

Output Parameters

You can select the output columns to display, report format, primary output column to sort by, 
sort direction, number rows to display per page, maximum number of rows to display per report, 
and if the output should be compressed. The output choices are CSV and HTML.  
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Sample Report

Project Status 

Based on your filters, this report displays the status of projects. It displays the ID, name, status, 
team size, timesheets, related entities #, and activities # with milestones and key milestones.  

Filter Parameters

You can filter on pull down status, initiative, project basics, project dates, organization hierarchy, 
finances, project custom fields, classification fields, and alignment tree. 

Output Parameters

You can select the primary output column to sort by, sort direction, number rows to display per 
page, maximum number of rows to display per report, and if the output should be compressed.  

The output choices are CSV and HTML. 
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Sample Report

Resource Status 

Based on your filters, this report displays the status of resources. It displays the name, login ID, 
status, last login date, timesheets, last timesheet submission date, and related entities.  

Filter Parameters

You can filter on initiative, resource basics, and resource filterable custom fields. 

Output Parameters

You can select the number rows to display per page, maximum number of rows to display per 
report, and if the output should be compressed.  

The output choices are CSV, PDF and HTML. 
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Sample Report
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Activity Detail Report 

This is a detailed report on each activity associated with a project. You can filter on initiative, 
program, all project activities, LET (Labor Expense Type) categories, and resource related fields. 
You can use the output generated from this report to create custom User-Defined Excel reports 
to view activity-related information for a specific project or group of projects. The output includes 
LET and labor expense categories. 

Filter Parameters

You can filter on pull-down status, initiative, project basics, project dates, project organization 
hierarchy, project methodology, project custom fields, project classification fields, program, 
project alignment tree, activity, activity custom fields, and resource basics. 

Output Parameters

You can select the maximum number of rows to display per report, view resource details, 
choose to display the WBS code column, and select the optional columns (Attachment, 
Predecessor, and Successors) to display.  

The output choices are CSV, MS Excel, PDF, and HTML. 

Note: To view resource information split into multiple rows per project, 
with each resource role displayed in separate rows, select Yes for 
Resource Details. If you select No, then each activity with all its 
assignments is contained within a single cell in that row. 

Sample Report

Metrics Listing Report 

Use the Metrics Listing report to display project metrics based on your filters. 

Filter Parameters
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You can filter to show metrics for a specified date range and select the recent number of metric 
data entries (1 to 50) to display. 

Output Parameters

You can select the output columns, the column to sort by, and the sort order.  

The available report formats are: CSV, HTML, and PDF. 

Sample Report

Project & Metrics Template 

Use the Project & Metrics Template report to display project metadata and details of associated 
metrics. 

Filter Parameters

You can filter on initiative, organization hierarchy, project classification fields, project basics, and 
metrics. You can filter to show metrics for a specified date range and select the recent number of 
metric data entries (1 to 50) to display. 

Output Parameters

You can select the output columns, the sort by column, and the sort order.   

The available report formats are: CSV, HTML, and PDF. 
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Sample Report

Non-WBS Activity Report 

Use the Non-WBS Activity report to display a detailed list of all non-WBS activities configured in 
your system. In addition, you can select to display custom fields that are specific to a non-WBS 
activity, and display linked activities in the report output. The Activity number column displays 
the internal ID of the activity.  

Filter Parameters

You can filter on initiative, pull-down status, project basics, project dates, organization hierarchy, 
project custom fields, project classification fields, project alignment tree, program, activity, 
activity custom fields and resource basics. 

Output (Display Options)

The available report formats are: CSV, HTML, and  MS Excel. You can also select the 
maximum number of rows to show per report.  

Output (Output Columns)

You can select the activity link columns to display and the activity custom fields to display in the 
output. 

Note: Only custom fields that are set to Visible by your administrator are 
displayed as output options. 

Sample Report
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Status Report Listing 

Use the Status Report Listing report to display a detailed list of all status reports currently in the 
system, including the details of each individual status report. You must select an initiative before 
running this report. From the Project Status Report Basics filter, you can select: 

 To include status report that are most recent or within a certain date range. 

 To view reports submitted by all resources or individual resources. 

 The number of status reports for each project that should be display in the report. 

Filter Parameters

You can filter on initiative, project basics, project dates, project organization hierarchy, project 
methodology, project custom fields, project classification fields, project alignment tree, and 
project status report basics. 

Output Parameters

The available report formats are: CSV, and HTML. 

Sample Report

Alignment Tree Report 

Based on your filters, this report displays a list of all objects associated with an alignment. 

Filter Parameters
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You can filter on module (Idea, Program, Project, and Proposal), initiative, alignment tree, 
alignment basics, alignment dates, project basics, project dates, project organization hierarchy, 
project classification fields, project methodology, project custom fields, proposal basics, proposal 
dates, proposal organization hierarchy, proposal classification fields, proposal custom fields, 
idea basics, idea dates, idea organization hierarchy, idea classification fields, idea custom field, 
program program dates, program custom fields, and program organization hierarchy. 

Output Parameters

You can select the report format, the primary column to sort on, the primary sort direction, the 
maximum rows per report, and if the output should be compressed. The available report format 
choices are CSV, MS Excel, and HTML.  

Sample Report

Pipeline Report 

Use the Pipeline report to list fields that are mapped across ideas, proposals, and projects. You 
can also use this report to display common custom fields across entities.  

Filter Parameters

You can filter on module, initiative, project basics, project dates, project organization hierarchy, 
project classification fields, project custom fields, proposal basics, proposal team, proposal 
organization hierarchy, proposal classification fields, proposal custom fields, idea basics, idea 
organization hierarchy, idea custom fields, program, and program organization hierarchy. 

Output (Output Parameters)

You can select the report format, primary output column to sort by, primary sort direction, 
maximum number rows to display per report, and if the output should be compressed.  

The output choices are CSV, HTML and MS Excel. 

Output (Output Columns)

You can select project, proposal, idea, and roles custom fields to display in the output. 



Report User Guide

42

Note: One output column is used to display custom fields that are 
mapped across entities. 

Sample Report

Deleted Records Report 

Use the Deleted Records report to view information on deleted entities. The following information 
is captured for deleted entities: Type, ID, Name, Additional Information, Deletion Date, Deleted 
By, Parent ID, Parent Type, and Initiative. You must have the View Deleted Entity Report  
access level permission to view this report. 

The Login ID of deleted resources is displayed in the Additional Information column. The report 
also shows the initiative for applicable entities. For deleted Projects and Proposals, the system 
only displays entities that match the initiative of the logged in user.  

Filter Parameters

You can select the entity, the deleted date (from), deleted time (from)deleted date (to), name ,ID, 
and deleted by.  

Output (Output Parameters)

You can select the report format, rows per page, maximum number rows to display per report, 
and if the output should be compressed. You can also choose to include child entities in the 
output. This option is available only if the selected entity is not a child entity. 

The output choices are CSV, HTML and MS Excel. 

Output (Output Columns)

You can select the program custom fields to displays. You can also select if you want the report 
to show program organization hierarchy, program finances, program statements and notes, and 
project details. 
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Sample Report

Program Listing 

Use the Program Listing report to view basic information on a program, view evaluation scores, 
and view the associated projects and proposals. You must have View Program Listing Report  
access level permission to view this report. 

Filter Parameters

You can filter on program, program dates, program custom fields, program organization 
hierarchy, and project basics. 

Output (Output Parameters)

You can select the report format, maximum number rows to display per report, and if the output 
should be compressed.  

The output choices are CSV, HTML and MS Excel. 

Output (Output Columns)

You can select the program custom fields to displays. You can also select if you want the report 
to show program organization hierarchy, program finances, program statements and notes, and 
project details. 

Sample Report
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Field Change History Report 

Use the Field Change History report to view a list of field changes that were made to the 
Projects, Proposals, and Programs modules. You must have View Program Listing Report  
access level permission to view this report. 

Filter Parameters

You can filter on initiative, entity, project basics, project dates, project organization hierarchy, 
project classification fields, project custom fields, proposal basics, proposal team, proposal 
dates, proposal organization hierarchy, proposal cl classification fields, proposal custom fields, 
program, program dates, program custom fields, and program organization hierarchy. 

Output (Output Parameters)

You can select the report format, the primary column to sort, the primary sort direction, 
maximum number rows to display per report, and if the output should be compressed.  

The output choices are CSV, HTML and MS Excel. 

Sample Report

Linked Projects 

Use the Linked Projects report to view all linked projects. You can select to view projects that are 
linked to other projects or view the projects and proposals that are linked from other projects. 
You must have View Program Listing Report  access level permission to view this report. 

Filter Parameters

You can filter on initiative, project basics, project dates, project organization hierarchy, project 
custom fields, and classification fields. 

Output (Output Parameters)
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You can select the report format, rows per page to display, primary column to sort by, primary 
sort direction, maximum number rows to display per report, and if the output should be 
compressed. You can also select the project output format (Linked From or Linked To). If you 
select Linked From, the system displays the proposals and projects that are linked from a 
project. If you select Linked To, the system displays projects that are linked to a project. 

The output choices are CSV, HTML and MS Excel. 

Sample Report
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Proposal Team Listing 

Based on your filters, this report displays a list of proposal team members with their approval 
information, or the initial project team members with their allocation information. From the Output 
tab, you can also choose to display detail efforts. If detail efforts were added to a proposal, this 
report displays one row for each effort entry for the resource instead of the total effort for the 
resource.  

Some of the columns that can display on your report  include: proposal ID, proposal name, 
initiative, role, member, login ID (column displays only if you have the permission Allow user to 
view/search login ID), team type (specifies Charter Team or Initial Project Team), team member 
ID, approval type (displayed for proposal team members), approval status (displayed for 
proposal team members), proposal status, proposal last updated date, updated by, project ID, 
and  external ID.  

When displaying a report of initial project team members, the following additional columns are 
displayed:  allocation ID, allocation type, allocation status (displays N/A if approval is not 
needed), allocation start date, allocation end date, percent allocation (shows the default 
allocation percent if no allocation percent is present), allocation efforts (shows detail efforts or 
the total effort), planned start date, and planned completion date. 

Notes: The Initial Project Team option displays only if the Initial Project 
Team is enabled. 

Filter Parameters

You can filter on initiative, proposal basics, proposal dates, classification fields, organization 
hierarchy, finances, proposal custom fields, program, and program organization hierarchy. 

Output Parameters

You can select the report format, primary column to sort by, sort direction, number rows to 
display per page, maximum number of rows to display per report, display report for proposal 
team or initial project team, and to display initial project team details efforts.  

The output choices are CSV and HTML.  

Sample Report (Proposal Team)

Sample Report (Initial Project Team)
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Program Eval Report 

Use the Program Eval report to view detailed evaluation information on a program. You must 
have View Program Eval Report  access level permission to view this report. 

Filter Parameters

You can filter on program, program dates, program custom fields, program organization 
hierarchy, project basics, and proposal basics. 

Output Parameters

You can select the report format, maximum number rows to display per report, and if the output 
should be compressed.  

The output choices are CSV, HTML and MS Excel. 
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Sample Report

Program Non-WBS Activity Report 

Use the Program Non-WBS Activity report to display a detailed list of all non-WBS activities, 
issues, and risks configured for Programs.The Activity number column displays the internal ID of 
the activity.  

Filter Parameters

You can filter on program, program dates, project organization hierarchy, program custom fields, 
activity. 

Output (Display Options)

The available report formats are: CSV, HTML, and  MS Excel. You can also select the 
maximum number of rows to show per report.  

Output (Output Columns)

You can select the activity link columns to display and the activity custom fields to display in the 
output. 
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Note: Only custom fields that are set to Visible by your administrator are 
displayed as output options. 

Sample Report

Project Reports (Summary Reports) 

In This Section 

Project Summary By Organization ........................................................................... 49 
Project Summary by Alignment ............................................................................... 50 
Project Classification Summary Report ................................................................... 50 
Project Summary Stats by Role ............................................................................... 51 
Closed Project Listing .............................................................................................. 52 
Active/Closed Project Report ................................................................................... 53 

Project Summary By Organization 

Based on your filters, this report displays the finance summary by organization. Before running 
this report, you must choose a Finance Template from the Filter tab. For each division it shows 
the project count (active, closed, and total), project finances, resource count and project lead 
count. 

Filter Parameters

You can filter on pull-down status, initiative, finances, project basics, project dates, organization 
hierarchy, project custom fields, classification fields, org hierarchy display options and alignment 
trees. 

Output Parameters
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The available report formats are: CSV, HTML, and PDF.  

Sample Report

Project Summary by Alignment 

Based on your filters, this report displays the project summary by alignment. It displays the 
alignment, project count (active and closed) and the project finances. Before running this report, 
you must choose a Finance Template, the Finance Type (Plan or Actual), the Alignment List and 
Note from the Filter tab. 

Filter Parameters

You can filter on pull-down status, initiative, alignment node, finances, project basics, project 
dates, organization hierarchy, project custom fields, and classification fields. 

Output Parameters

The available report formats are: CSV, PDF, and HTML. 

Sample Report

Project Classification Summary Report 

Based on your filters, this report displays the classification summary report. You can have up to 
four classification fields enabled in your system. The labels for these classification fields depend 
on your configuration. Before running this report, you must choose a Finance Template from the 
Filter tab.  

Filter Parameters
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You can filter on pull-down status, initiative, finances, organization hierarchy, project basics, 
project dates, classification fields, project custom fields, and alignment trees. 

Output Parameters

The available report formats are: CSV, PDF, and HTML. 

Sample Report

Project Summary Stats by Role 

Based on your filters, this report displays the project summary statistics by resource roles. 
Before running this report, you must choose an Initiative from the Filter tab. 

Filter Parameters

You can filter on pull-down status, initiative, reporting date range, organization hierarchy, and 
finances. 

Output Parameters

You can choose the report format, if you want to compress the output by generating a .zip file, 
and include or exclude graphs from the report. 

The available report formats are: CSV, PDF, and HTML.  
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Sample Report

Closed Project Listing 

Based on your filters, this report displays all closed projects. It displays the initiative, project 
number, name and planned project close date and project type. 

Filter Parameters

You can filter on pull-down status, initiative, organization hierarchy, and finances. 

Output Parameters

You can choose the report format and if you want to compress the output by generating a .zip 
file. 

The available report formats are: CSV, PDF, and HTML  

Sample Report
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Active/Closed Project Report 

Based on your filters, this report displays all active and closed projects. It displays the initiative, 
project number, name, close date, project type, and the finances associate with the project. 

Filter Parameters

You can filter on pull-down status, initiative, organization hierarchy, and finances. 

Output Parameters

You can choose the report format and if you want to compress the output by generating a .zip 
file. 

The available report formats are: CSV, PDF, and HTML  

Sample Report
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Project Report (Detail Reports) 

In This Section 

Project Listing by Role ............................................................................................. 54 
Project Final Report ................................................................................................. 55 
Project Review Report ............................................................................................. 56 
Project Control Report ............................................................................................. 57 
Project Notes Report ............................................................................................... 58 
Project Issues Report .............................................................................................. 59 
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Idea Evaluation Report ............................................................................................ 60 
Proposal Evaluation Report ..................................................................................... 61 
Project Evaluation Report ........................................................................................ 62 
Project Request Signoff Report ............................................................................... 62 
Project Alignment Report ......................................................................................... 63 

Project Listing by Role 

Based on your filters, this report displays the projects by resource roles. It displays the project 
manager, project name, project ID, completion, status, type, YTD realized benefits, current 
forecast, % estimated savings, % defect reduction, and defect % of entitlement.  Before running 
this report, you must choose an Initiative and Resource Role from the Filter tab. 

Filter Parameters

You can filter on pull down status, initiative, reporting date range, organization hierarchy, and 
finances. 

Output Parameters

You can select the report format and if the output should be compressed. The available report 
formats are CSV, PDF and HTML.  
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Sample Report

Project Final Report 

Based on your filters, this report displays the project final report. It displays the project definition, 
project summary, project details, stage conclusions, team members, control plan tasks, project 
documentation, and custom fields. 

Filter Parameters

You can filter on pull down status, initiative, project basics, organization hierarchy, project 
custom fields, and finances. 

Output Parameters

You can select the report format, maximum number of rows to display per report, and if the 
output should be compressed. The available report formats are CSV, PDF and HTML.  
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Sample Report

Project Review Report 

Based on your filters, this report displays the aggregate project review report. It displays the 
project name, project activities, analysis tools, issues, and custom fields. 

Filter Parameters

You can filter on pull-down status, initiative, project basics, organization hierarchy, and project 
custom fields. 

Output Parameters

You can select the report format, maximum number of rows to display per report, and if the 
output should be compressed. The available report formats are: CSV, HTML, and PDF.  
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Sample Report

Project Control Report 

Based on your filters, this report displays the project control report.  

Filter Parameters

You can filter on pull-down status, initiative, project basics, organization hierarchy, and project 
custom fields, classification fields. 

Output Parameters

You can select the report format, maximum number of rows to display per report, and if the 
output should be compressed. The available report formats are: CSV, HTML, and PDF.  
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Sample Report

Project Notes Report 

Based on your filters, this report displays the project notes report. 

Filter Parameters

You can filter on pull-down status, initiative, project basics, organization hierarchy, and project 
custom fields. 

Output Parameters

You can select the report format, maximum number of rows to display per report, and if the 
output should be compressed. The available report formats are: CSV, HTML, and PDF. If the 
report format is CSV, the output shows one row per note, and returns information for projects 
that contain notes.  
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Sample Report

Project Issues Report 

Based on your filters, this report displays the project issues report. 

Filter Parameters

You can filter on pull-down status, initiative, project basics, organization hierarchy, and project 
custom fields. 

Output Parameters

You can select the report format, maximum number of rows to display per report, and if the 
output should be compressed. The available report formats are: CSV, HTML, and PDF.  
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Sample Report

Project Storyboard 

Based on your filters, a project storyboard is created. The output option is MS PowerPoint. 
Follow the instruction under the Help tab to export project data to Microsoft PowerPoint. 

Filter Parameters

You can filter on pull down status, initiative, project basics, project dates, organization hierarchy, 
project custom fields, finances, and storyboard. 

Output Parameters

You can select the maximum number of projects to display and the report format. The available 
report format is MS PowerPoint.  

Idea Evaluation Report 

Based on your filters, this report displays the evaluation of all ideas in the system.  

Filter Parameters
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You can filter on pull down status, idea basics, organization hierarchy and idea custom fields. 

Output Parameters

You can select the report format, maximum number of rows to display per report, and if the 
output should be compressed. The available report formats are CSV, PDF and HTML.  

Sample Report

Proposal Evaluation Report 

Based on your filters, this report displays the evaluation of all charters in the system.  

Filter Parameters

You can filter on pull down status, initiative, proposal basics, classification fields, and 
organization hierarchy. 

Output Parameters

You can select the report format and if the output should be compressed. The available report 
format choices are CSV, PDF and HTML.  
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Sample Report

Project Evaluation Report 

Based on your filters, this report displays an evaluation of all projects in the system.  

Filter Parameters

You can filter on pull down status, initiative, project basics, classification fields, organization 
hierarchy, and project custom fields. 

Output Parameters

You can select the report format and if the output should be compressed. The available report 
format choices are CSV, PDF and HTML.  

Sample Report

Project Request Signoff Report 

Based on your filters, this report displays the sign-off status for charter team members. 

Filter Parameters
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You can filter on initiative, proposal basics, proposal team, proposal organization hierarchy, 
proposal classification fields, and proposal custom fields. 

Output Parameters

You can select the report format, the primary column to sort on, the primary sort direction, the 
maximum rows per report, and if the output should be compressed. You can also select the 
output columns to display. 

The available report format choices are CSV, MS Excel, and HTML.  

Sample Report

Project Alignment Report 

Based on your filters, this report displays a list of all projects, their alignments, and alignment 
contribution.  

Filter Parameters

You can filter on initiative, project basics, project dates, organization hierarchy, project custom 
fields, alignment tree, alignment dates. 

Output Parameters

You can select the report format, the primary column to sort on, the primary sort direction, the 
maximum rows per report, and if the output should be compressed. You can also select the 
output columns to display. The available report format choices are CSV, MS Excel, and HTML.  
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Sample Report

Resource Reports (Detail Reports) 

In This Section 

Resource Professional Certifications ....................................................................... 64 
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Heat Map by Role .................................................................................................... 68 
Heat Map by Project ................................................................................................ 69 
Resource Utilization Chart ....................................................................................... 70 
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Resource Allocation Report ..................................................................................... 73 
Heat Map Legends .................................................................................................. 73 

Resource Professional Certifications 

Based on your filters, this report displays all the certificates received by resources.  

Filter Parameters

You can filter on pull down status, initiative, resource basics, and organization hierarchy. 

Output Parameters

You can select the primary output column to sort by, sort direction, maximum number of rows to 
display per report, and if the output should be compressed. The output choices are CSV and 
HTML.  
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Sample Report

Resource Expertise/Skills 

Based on your filters, this report displays the skills and expertise the resources have.  

Filter Parameters

You can filter on pull down status, initiative, resource basics, and organization hierarchy. 

Output Parameters

You can select the primary output column to sort by, sort direction, maximum number of rows to 
display per report, and if the output should be compressed. 

The output choices are CSV, PDF and HTML. 
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Sample Report

Resource Assets 

Based on your filters, this report displays all resource assets. 

Filter Parameters

You can filter on pull down status, initiative, resource basics, and organization hierarchy. 

Output Parameters

You can select the primary output column to sort by, sort direction, maximum number of rows to 
display per report, and if the output should be compressed. The output choices are CSV, PDF 
and HTML.  

The output choices are CSV, PDF and HTML. 
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Sample Report

Heat Map by Resource 

Based on your filters, this report displays a heat map by resource. It displays the 
resource/project, project count, planned effort for resources (PL), actual effort for resource (AC), 
planned utilization (PL/CP %), and the actual utilization (AC/CP %). For more information on the 
heat map thresholds used and a description of the column headers, click the Legend link. The 
cells highlighted in green indicate that the resource is underutilized, and cells highlighted in red 
indicate that the resource is overbooked.  

Filter Parameters

You can filter on pull down status, initiative, reporting date range, resource basics, resource 
filterable custom fields, resource organization hierarchy, project basics, project dates, project 
organization hierarchy, project finances, program, project custom fields, project classification 
fields, project alignment tree, proposal basics, proposal classification fields, and proposal 
custom fields 

Output Parameters

You can select the following filters: 

 Display Filters: report format, maximum rows per report, rows per page, and hide rows with 
zero effect. The report format choices are CSV and HTML.  

 Row Filters: display named resource, display TBD assignments, display projects, display 
proposals, display assigned allocations, display unassigned allocations, display activities, 
and display team/overhead. 

 Column Filters: display project count, display capacity, display requested, display committed, 
display total demand, display percent allocations/approvals, display planned, display actual, 
and display percent utilization. 

The output choices are CSV and HTML. 
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Sample Report

Heat Map by Role 

Based on your filters, this report displays a heat map by resource roles. From the Filter tab, you 
must choose an Initiative before running this report. It displays the role/ resource/project, project 
count, planned effort for resources (PL), actual effort for resource (AC), planned utilization 
(PL/CP %), and the actual utilization (AC/CP %). For more information on the heat map 
thresholds used and a description of the column headers, click the Legend link. The cells 
highlighted in green indicate that the resource is underutilized, and cells highlighted in red 
indicate that the resource is overbooked.  

Note: The total capacity at the role level only indicates potential
capacity. The capacity is counted more than once if a resource has 
multiple roles. 

Filter Parameters

You can filter on pull down status, initiative, reporting date range, resource basics, resource 
filterable custom fields, resource organization hierarchy, project basics, project dates, project 
organization hierarchy, project finances, program, project custom fields, project classification 
fields, project alignment tree, proposal basics, proposal classification fields, proposal 
organization hierarchy, and proposal custom fields 

Output Parameters

You can select the following filters: 

 Display Filters: report format, maximum rows per report, rows per page, and hide rows with 
zero effect. The report format choice is HTML.  

 Row Filters: display named resource, display TBD assignments, display projects, display 
proposals, display assigned allocations, display unassigned allocations, display activities, 
and display team/overhead. 

 Column Filters: display project count, display capacity, display requested, display committed, 
display total demand, display percent allocations/approvals, display planned, display actual, 
and display percent utilization. 
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The report output format is HTML. 

Sample Report

Heat Map by Project 

Based on your filters, this report displays a heat map by project. It displays the project/resource, 
resource count, planned effort for resources (PL), actual effort for resource (AC), planned 
utilization (PL/CP %), and the actual utilization (AC/CP %). For more information on the heat 
map thresholds used and a description of the column headers, click the Legend link. If your 
report has a cell highlighted in orange, it indicates that the committed effort as a percentage of 
capacity for the activity is in the mid range. If a cell is highlighted in red, it indicates that the 
activity's planned utilization is very high, and cells highlighted in green indicate very low 
utilization. 

Filter Parameters

You can filter on pull down status, initiative, reporting date range, resource basics, resource 
filterable custom fields, resource organization hierarchy, project basics, project dates, project 
organization hierarchy, project finances, program, project custom fields, project classification 
fields, project alignment tree, proposal basics, proposal classification fields, proposal 
organization hierarchy, and proposal custom fields 

Output Parameters

You can select the following filters: 

 Display Filters: report format, maximum rows per report, rows per page, and hide rows with 
zero effect. The report format choice is HTML.  

 Row Filters: display named resource, display TBD assignments, display projects, display 
proposals, display assigned allocations, display unassigned allocations, display activities, 
and display team/overhead. 
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 Column Filters: display project count, display capacity, display requested, display committed, 
display total demand, display percent allocations/approvals, display planned, display actual, 
and display percent utilization. 

The report format choice is HTML.  

Sample Report

Resource Utilization Chart 

Based on your filters, this report displays the resource utilization. It shows the planned utilization 
% and the actual utilization % for all resources. 

Filter Parameters

You can filter on pull down status, initiative, reporting date range, resource basics, resource 
filterable custom fields, resource organization hierarchy, project basics, project dates, project 
organization hierarchy, project finances, program, project custom fields, project classification 
fields, project alignment tree, proposal basics, proposal classification fields, proposal 
organization hierarchy, and proposal custom fields 

Output Parameters

You can select the following filters: 

 Display Filters: report format, maximum rows per report, compress output, and display 
resource level chart. The report format is HTML.  

 Chart Filters: display mode (percentage or total), display planned, display actual, display 
capacity, display requested, display committed, and display total demand. 
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Sample Report

Project Effort Chart 

Based on your filters, this report displays project effort by project. It shows the planned and the 
actual effort. 

Filter Parameters

You can filter on pull down status, initiative, reporting date range, resource basics, resource 
filterable custom fields, resource organization hierarchy, project basics, project dates, project 
organization hierarchy, project finances, program, project custom fields, project classification 
fields, project alignment tree, proposal basics, proposal classification fields, proposal 
organization hierarchy, and proposal custom fields 

Output Parameters

You can select the following output filters: 

 Display Filters: report format, maximum rows per report, and compress output. The report 
format is HTML.  

 Chart Filters: display planned, display actual, display capacity, display requested, display 
committed, and display total demand. 

Sample Report



Report User Guide

72

Heat Map by Resource CSV 

Based on your filters, this report displays a heat map by resource.  

Filter Parameters

You can filter on pull down status, initiative, reporting date range, resource basics, resource 
filterable custom fields, resource organization hierarchy, project basics, project dates, project 
organization hierarchy, project finances, program, project custom fields, project classification 
fields, project alignment tree, proposal basics, proposal classification fields, proposal 
organization hierarchy, proposal custom fields, and program. 

Output Parameters

You can select the following filters: 

 Display Filters: report format, maximum rows per report, and hide rows with zero effect. The 
report format choices are CSV, XLS, and HTML.  

 Row Filters: display named resource, display TBD assignments, display projects, display 
proposals, display assigned allocations, display unassigned allocations, display activities, 
and display team/overhead. 

 Column Filters: display project count, display capacity, display requested, display committed, 
display total demand, display percent allocations/approvals, display planned, display actual, 
and display percent utilization. 

The output choices are CSV, XLS, and HTML. 

Sample Report
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Resource Allocation Report 

Based on your filters, this report displays the resource allocation. It shows the project ID, project 
name, project role, resource name, status, approval role, duration, percentage/effort, 
pending/unapproved requested effort for resource from, pending/unapproved requested effort to, 
approved/committed effort for resources from, approved/committed effort for resources to, 
preferred users, preferred skills, pending/unapproved requested effort for resources%, 
approved/committed effort for resources, rate $, pending/unapproved requested effort for 
resource $, and approved/committed effort for resources $. 

Filter Parameters

You can filter on initiative, reporting date range, resource basics, resource filterable custom 
fields, resource organization hierarchy, project basics, project dates, project organization 
hierarchy, project finances, program, project custom fields, project classification fields, project 
alignment tree, proposal basics, proposal classification fields, proposal organization hierarchy, 
and proposal custom fields. 

Output Parameters

You can select the following filters: 

 Display Filters: report format, maximum rows per report, rows per page, and hide rows with 
zero effect. The report format is CSV and HTML.  

 Row Filters: display projects, display proposals, display assigned allocations, display 
unassigned allocations, display named resources, and display TBD assignments. 

Sample Report

Heat Map Legends 

 CP(hours) 

Resource Capacity. The number of working hours per week by a resource divided by the 
number of working days per week.  

Example: If a user works 40 hours a week, there are 5 work days in a week and 22 working 
days in a month, then the capacity for the resource for that month is 40/5* 22= 176 hours. 
Resource capacity is fixed and the number of work days in EnterpriseTrack is fixed at 5. 
General calendar holidays and non-working days do not affect resource capacity. 
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 RQ(hours)

 Pending/Unapproved Requested Effort for Resources. It is the sum of the demand for a role 
or resource in the form of allocations from projects. 

 CM(hours)

Approved/Committed Effort for Resources. When Requested Effort (RQ) is approved it 
becomes Committed Effort and RQ can be approved is full or partial. If a resource role 
doesn't require an approved then as soon as effort is allocated it becomes committed effort. 

 TD(hours) 

Total Demand (RQ+CM). It is the sum of Requested Effort (RQ) for a role or resource and 
the Committed Effort (CM).  

 RQ/CP(Percent)

Requested Effort as a percent of Capacity. 

 CM/CP(Percent)

Committed Effort as a percent of Capacity. 

 TD/CP(Percent) 

Total Demand as a percent of Capacity. 

 PL(hours)

Planned Effort for Resources. The sum of an individual resource's planned effort for each 
assigned task for a given time period. It is not double-counted when rolled up by resource or 
role.  

Example: If John Smith plans to work 110 hours as a DBA and 40hrs as a Unix Administrator 
for the month of January, then the PL for John for the month of January is 110 +40 = 150 
hrs. If Mary Jane plans to work 100 hrs as a DBA in the month of January then the PL for 
DBA is 110 + 100= 210 hrs. The PL for Mary is 100 hrs. The PL for Unix Administrator is 40 
hrs. 

 AC(hours) 

Actual Effort. The sum of the actual effort by a resource for a given time period. This can 
come from timesheets. No double counting is done when rolled up by resource or role.  

Example: If John Smith has worked 93 hrs as a DBA and 45 hrs as a Unix Administrator in 
January, then the AC for John is 93+45 = 138 hrs. If Mary Jane worked 97 hrs. as DBA in 
January, then the AC for Mary is 97. The AC for DBA is 93+97=190 and the AC for Unix 
Administrator is 45. 

 PL/CP(Percent) 

Planned Utilization. 

 AC/CP(Percent)

Actual Utilization. 
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Timesheet Reports 

Timesheet Report by Project 

Based on your filters, this report displays timesheet reports by projects. It displays the project 
name, role, team member, activities, the number of hours reported on timesheet, total hours, 
rate, and cost. If the date range is one week or less, the generated report provides a detailed 
view for each day of the week. If the date range is more than a week, the generated report 
displays a summarized view for the entire period. 

Filter Parameters

You can filter on initiative, pull-down status, timesheet basics, project basics, project custom 
fields,  project organization hierarchy, project team, finances, and program. You can filter on 
project team, only if one initiative is selected. 

Output Parameters

You can select the report format, choose to compress the output, display cost, display project 
overhead categories and activity details, hide rows with zero effect, and display overtime in 
separate columns. The output hours to display is determined by the date range selected in the 
Filter tab. An error message displayed if the output hours if not within supported range. You can 
select from one of the following options: 

 By Day of Week: if the date range is less than a week. This option displays the report output 
by day for a one week period. 

 By Week: if the date range is more than a week, but less than 6 weeks. This output displays 
columns for each week. 

 By Month: if the date range is less than 12 months. This output displays columns for each 
month. 

 By Total: if the date range is more than 12 months. This output displays the total hours for 
the selected date range on a weekly basis. 

 The available report format choices are: CSV, PDF and HTML. 
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Sample Report (By Day of Week)

Sample Report (By Week)
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Sample Report (By Month)

Sample Report (Total)

Timesheet Report by Resource 

Based on your filters, this report displays timesheet report by resource. It shows the resource 
name, project name, role, activities, the number of hours reported on timesheet, total hours, rate, 
and cost. If you select to view non-project overhead categories, you can view the non-project 
time reporting categories and the non-working time reporting categories. This report include 
numbers only from active projects and not completed or closed projects. 

Filter Parameters

You can filter on initiative, pull-down status, timesheet basics, resource basics, resource custom 
fields, resource organization hierarchy, project team, finances, and program. You can filter on 
project team, only if one initiative is selected. 
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Output Parameters

You can choose to compress the output, display cost, display project overhead categories and 
activity details, display non project overhead categories, hide rows with zero effect, and display 
overtime in separate columns. The output hours to display is limited by the date range selected 
in the Filter tab. An error message displayed if the output hours if not within supported range. 
You can select from one of the following options: 

 By Day of Week: if the date range is less than a week. This option displays the report output 
by day for a one week period. 

 By Week: if the date range is more than a week, but less than 6 weeks. This output displays 
columns for each week. 

 By Month: if the date range is less than 12 months. This output displays columns for each 
month. 

 By Total: if the date range is more than 12 months. This output displays the total hours for 
the selected date range on a weekly basis. 

The available report format choices are: CSV, PDF and HTML. 

Sample Report

Timesheet Weekly Status Report 

Based on your filters, this timesheet report shows status and approval information for each 
category (project, non-project, and non-working) along with cost details for each resource by 
week. It shows the week range, submitter, project number, project start date, reporting category, 
status, approver, approval date, total hours, standard hours, standard rate, overtime hours, and 
overtime rate. 

Filter Parameters

You can filter on pull down status, initiative, timesheet basics, resource basics, resource custom 
fields, resource organization hierarchy, project basics, and finances.  
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Output Parameters

You can choose to compress the output, display cost, display project overhead categories and 
activity details, display non project overhead categories, hide rows with zero effect. 

The available report format choices are: CSV, PDF and HTML. 

Sample Report

Timesheet Detail Report 

This is a detailed report of timesheets. You can export the data generated by this report to 
Microsoft Excel to view the Plan versus Actual data and the cost across various dimensions. You 
can use Excel to format the data, group rows and columns, aggregate by quarters, years, or by 
fiscal period. 

Notes:

 The Total Plan Effort column in this report is an information only 
column and the value will be the whole plan effort at activity level. 
This value may be repeated when the report is run to show the 
breakdown at day level, in such cases care should be taken not to 
double count the plan effort. 

 The cost data is shown only for users that have the required 
permissions to view cost information. 

 The resource rates are picked for the rate at assignment level. For 
non-project time and non-working time the standard rate at the 
resource level is used. 

 If the resource plays more than one role in a project or an activity, the 
time reported from the timesheet will be equally distributed among all 
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the roles and then costed with the respective role rate. 

Filter Parameters

You can filter by pull-down status, initiative, timesheet basics, project basics, project custom 
fields, project organization hierarchy, resource basics, resource filterable custom fields, resource 
organization hierarchy, finances, and program. 

Output Parameters

You can also set the following output display filters: Compress Output, Show Cost, Show Project 
Overhead Categories, Show Activity Details Show Non-project Categories, Include disabled 
Time Reporting Categories, Show Actual Effort breakdown at day level, and Suppress rows 
where Actual Total Effort is zero. If you select the Show Actual Effort breakdown at day level
option, the report displays the actual effort by resource assignment for each day. Leave this 
option unchecked to view actual effort aggregated for the selected time period. You can also 
select the output custom field to display. 

The output choices are CSV, HTML, and MS Excel. 

Sample Report

Timesheet Corrections Detail Report 

The Timesheet Corrections Detail Report displays a detailed report with correction data for all 
timesheets that were corrected after the timesheet close period. If no correction dates are 
entered, then the correction data for the current week is displayed. 

Filter Parameters

You can filter by initiative, timesheet basics, project basics, project custom fields, project 
organization hierarchy, resource basics, resource filterable custom fields, resource organization 
hierarchy, finances, and program.  

Output Parameters



User Defined Excel Reports

81

You can also set the following output filters: Compress Output, Show Cost, Show Project 
Overhead Categories, Show Activity Details Show Non-project Overhead Categories, Include 
disabled Time Reporting Categories, Show Actual Effort breakdown at day level, and Suppress 
rows where Actual Total Effort is zero. If you select the Show Actual Effort breakdown at day 
level option, the report displays the actual effort by resource assignment for each day. Leave 
this option unchecked to view actual effort aggregated for the selected time period. You can also 
select the output custom field to display. 

The output choices are CSV, HTML, MS Excel, and PDF. 

Sample Report

User Defined Excel Reports 

User-Defined Excel Reports (also referred to as Composite reports) use Microsoft Excel (as a 
tool for creating charts, pivot tables and tabular data in a highly customer-specific format) and 
EnterpriseTrack (as a single location repository and a source for real-time data across your 
entire organization) to generate reports. As a result, your organization can enjoy the flexibility 
and control of your favorite desktop tool and the data reliability and productivity of a centralized 
on-demand source of project and portfolio information.  

For example, you can use User-Defined Excel reports if you need a Pivot Table report of 
Projects Finances by Organization and also display on the same page a chart of Project 
Finances by Time. Once you are setup with an Excel report template, you can then run the Pivot 
Table report as often as needed to access the updated report fed with the latest data from the 
system in an Excel output format.  

You can create custom reports using one or more Ad-hoc templates as inputs and you can 
choose to output it as an XLS or as a zip file.  You can also view the history, email and share 
these reports.  

In This Section 

Creating User-Defined Reports ............................................................................... 81 

Creating User-Defined Reports 

To create User-Defined Reports, do the following:  

1) Navigate to Standard Reports by selecting Go To >Reports >Standard from the Top 
Navigation bar. 
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2) From the Tree pane, select the My Report folder and select any reports sub-folder 
underneath. If you don’t have a sub-folder underneath the My Report folder, then you must 
first create a sub-folder. For example, you can create a sub-folder called Excel-Based 
Report. 

3) From the List pane, click the Create User-Defined Report button, and choose
User-Defined Excel Report. 

4) From the General tab enter a name for the report. 

5) From the Data Source tab, you can add, or delete one or more Ad-hoc templates or you can 
select any of the available Standard Report templates. The Standard Reports that are 
displayed are the ones that have a tabular output. Most reports do, but those that have only 
a PDF output are not shown in the list of available reports.  

Notes:

 You must choose a report that does not require any parameters at 
run-time. The report should produce an output without setting any 
parameters. 

 It is recommended that you make a copy of the Standard Report that 
you want to use as a data feed into your My Reports folder. This way 
you can set all necessary parameters that the Standard Report may 
need. If you are using Ad-hoc reports, you should similarly ensure 
that the reports do not require any input parameters 

6) Enter a name, select a source template, and enter an Order ID. You can click on the Add 
More link to add more source templates. This name will become the name of the tab in the 
output Excel report 

7) The Source is where you specify the Ad-hoc or Standard report templates that will be used 
as the data source to feed into your Report Template. You can have several sources of 
Ad-hoc or Standard reports. 

8) From the Output tab select the report format (XLS or ZIP). Select if you want to edit the 
parameters during runtime. 

9) Click Run Report.  
You can open the report in Excel and add your own tabs. Your tabs can contain any Excel 
formulas, coloring, borders, text, charts, pivot tables and even Macros. These can refer to 
cells in the EnterpriseTrack data feed tabs.  
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Note: You should not make any changes or edits to the tabs fed from 
EnterpriseTrack – these will be lost in a subsequent run of the report. 
You can however make any number of your own tabs. These tabs can 
have formulas that refer to the tabs of data fed by EnterpriseTrack. In 
this way you can create any arbitrary Excel output you wish. Note that 
when you refer to data ranges in the data tabs from EnterpriseTrack, you 
should know that there may be fewer or more rows in each run of the 
report depending on the underlying data set chosen. This can often be 
handled by just naming the column of data as the range in the Excel 
formula (e.g. A: A or C: C). 

10) From the Details tab, click on the General tab and upload the file you created in the 
previous step as the Report template. This template will then be populated at the next 
execution of the report, with the latest data. If you wish to change the template by modifying 
its appearance or any formulas, you can re-upload the modified template at any time. 

11) From the Output tab select the report format (XLS or ZIP). Select if you want to edit the 
parameters during runtime. 

12) Click the Save button. 

Ad-Hoc Reports 

To access a set of pre-defined Ad-hoc Report templates, from the Top Navigation bar select Go 
To> Reports > Ad-hoc. 

You can also use the Left Navigation bar to select Reports > Ad-hoc Reports. 

In This Section 

Managing Ad-Hoc Reports ...................................................................................... 83 
List of Ad-Hoc Reports ............................................................................................ 85 

Managing Ad-Hoc Reports 

You can edit the predefined templates by specifying the parameter values, selecting the 
columns to display, and specifying the sort orders. You can also view saved templates created 
by other users by changing the filter criteria. 

Editing Templates 

To edit a template, click on the [Edit] link next to the template. Click on the tabs to modify the 
report and click on the Save As… button. 

General Tab

Modify the name, and description. Select if you want the default output parameter to be HTML, 
PDF, XLS, or XML. Also select if you want to publish this report. 



Report User Guide

84

Parameters Tab

Select the parameters and their values. You can choose to edit the parameter at runtime. 

Column Selection Tab

Select the columns you want to display. Click the right or left buttons to select/omit columns from 
the report. You can also use the Move Up and Move Down buttons to change the order of the 
selected columns.  

Column Details Tab

Select the column name and enter a description. 

Sorting Tab

Select the sorting order for the columns. 

Run Test Report

Select the output format (HTML, PDF, XLS, or XML) and enter values for any required 
parameters. Click the Run Report button. 

Copying Templates 

To copy an existing template: 

1) Click the [Edit] link next to the template you want to copy. 

2) Click on the tabs to modify the report and  

3) Click the Save As… button.  

4) Enter a name and description for this report.  

5) Select if you want publish this report. 

6) Click Save. 

Setting Filters 

To set filters: 

1) Click the More Filters… button. 

2) Select the scope, and enter the filter criteria. 

3) Click the Apply.  

Running Ad-Hoc Reports 

To run an Ad-hoc report:  

1) Select a report and click on the [Run] link. 

2) From the Run Ad-hoc Report screen, select the output parameter and enter any mandatory 
parameters. 

3) Click the Run Report button. The screen refreshes to display the report. 
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List of Ad-Hoc Reports 

The table below lists the pre-defined ad-hoc reports. 

Report Name Description/Purpose 

Asset Listing Report Get all the asset related information for all resources. 

Charter Template A template for charter reports. 

Executive Notes Listing 
Template 

Lists all executive notes. 

Finance Validation Report 
Template 

Display finance validation data. 

Idea Template A template for idea reports. 

Issues Listing Report Lists issues in all projects. 

Metrics Listing Report Get all the metrics related information for all projects. 

Program Template A template for program reports. 

Project & Metrics Template This template combines project and metrics data. 

Project Listing Report Displays project details including a list of key team 
members. 

Project Template A template for project reports.  

Note: The Current Phase column is populated only if the 
project roadmap is gated. 

Charter Team Member 
Listing Report 

Lists all charter team members. 

Resource Certification 
Listing Report 

Lists all certifications taken by resources. 

Resource Template A temple for resource reports. 

Role Based Permission List Lists all role based permissions. 

Team Member Listing 
Report 

Lists all team members. 

Title Based Permission List Display all title based permission mapping. 



86

Oracle Instantis EnterpriseTrack Report User Guide 

Copyright © 2000, 2018, Oracle and/or its affiliates. All rights reserved. 
Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be 
trademarks of their respective owners. 

Intel and Intel Xeon are trademarks or registered trademarks of Intel Corporation. All SPARC 
trademarks are used under license and are trademarks or registered trademarks of SPARC 
International, Inc. AMD, Opteron, the AMD logo, and the AMD Opteron logo are trademarks or 
registered trademarks of Advanced Micro Devices. UNIX is a registered trademark of The Open 
Group. 

This software and related documentation are provided under a license agreement containing 
restrictions on use and disclosure and are protected by intellectual property laws. Except as 
expressly permitted in your license agreement or allowed by law, you may not use, copy, 
reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish or 
display any part, in any form, or by any means. Reverse engineering, disassembly, or 
decompilation of this software, unless required by law for interoperability, is prohibited. 

The information contained herein is subject to change without notice and is not warranted to be 
error-free. If you find any errors, please report them to us in writing. 

If this is software or related documentation that is delivered to the U.S. Government or anyone 
licensing it on behalf of the U.S. Government, the following notice is applicable:  

U.S. GOVERNMENT END USERS: Oracle programs, including any operating system, 
integrated software, any programs installed on the hardware, and/or documentation, delivered to 
U.S. Government end users are “commercial computer software" pursuant to the applicable 
Federal Acquisition Regulation and agency-specific supplemental regulations. As such, use, 
duplication, disclosure, modification, and adaptation of the programs, including any operating 
system, integrated software, any programs installed on the hardware, and/or documentation, 
shall be subject to license terms and license restrictions applicable to the programs. No other 
rights are granted to the U.S. Government. 

This software or hardware is developed for general use in a variety of information management 
applications. It is not developed or intended for use in any inherently dangerous applications, 
including applications that may create a risk of personal injury. If you use this software or 
hardware in dangerous applications, then you shall be responsible to take all appropriate 
failsafe, backup, redundancy, and other measures to ensure its safe use. Oracle Corporation 
and its affiliates disclaim any liability for any damages caused by use of this software or 
hardware in dangerous applications. 

This software or hardware and documentation may provide access to or information on content, 
products and services from third-parties. Oracle Corporation and its affiliates are not responsible 
for and expressly disclaim all warranties of any kind with respect to third-party content, products, 
and services. Oracle Corporation and its affiliates will not be responsible for any loss, costs, or 
damages incurred due to your access to or use of third-party content, products, or services. 

Legal Notices 
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